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The Association of PC User Groups (APCUG) will be 
holding a Regional Conference July 15 – 17, 2011 in 
Independence, Ohio at the Crowne Plaza.  What a great 
opportunity to experience a technology conference with 
fellow User Groups members from around the country 
(and beyond)! 
 

During the years that this conference was held in Las 
Vegas,  Edie Lewandowski, Kathy Ratcliffe,  Kaye Coller 
and Lou Koch attended at different times.  I attended 
this event two years ago when it was held in Newark, 
Ohio.   
 

The conference is not as big as it was when it was held 
in Las Vegas.  When it was held there, it was in con-
junction with the Consumer Electronics Show.  But as 
years went by the size of the APCUG meeting kept get-
ting smaller until it was decided to hold regional meet-
ings around the country instead of Las Vegas where it 
was more expensive. 
 

The conference in 2009 in Newark was held at the 
Cherry Valley Lodge and Conference Center and Water-
park.   I had a lovely room and it was a beautiful facility!  
I am always one who is eager to attend meetings and 
classes and take advantage of learning opportunities.  It 
was nice to meet all kinds of computer lovers from all 
around and take advantage of the various break-out 
groups and speakers. 
 

This year’s conference will be held nearby and will only 
cost $50 to attend the weekend conference.  When it 
was held in Las Vegas it cost $175 and included more 
meals and goodies.  More corporate sponsors had big-
ger budgets ―back then‖. 
 

Several of the officers will be attending this year and I 
hope that lots of our members will take advantage of 
this event since it is so close.   
 

The hotel where the Conference is being held is right off 
of the highway and easy to get to.  You can attend one 
day or the whole weekend and you have the option of 
driving back and forth or getting a room and enjoying a 
get-away! 
 

There is more information about the Conference at 
http://cleveland.apcug.org.  Including a tentative sched-
ule of sessions as well as information about reserving a 
room and/or signing up for the Conference.  

I hope to see lots of you there!! 

 

    Sandee 

Ohio Computer Repair Service 
47375 Cooper Foster Park Road 

Amherst, Ohio 44001 
(440) 984-5265 

 

The Problem: 

Computers can be fun and frustrating at the same time. 
This may be a surprise to some, but 90% of everything that goes 
wrong with a computer is configuration related. The problem is, 

there are just too many settings to change and modify, and most 
people don't even know where these settings are.  

The Answer: 
You could read and study like I did for the last 14 years. You 

could experiment with your computers on a daily basis until you 
get it right, or search the Internet and find more sites than any 

ten people could read in a lifetime. You could accidentally break 
your computer more times than you care to remember, or you 

can call us, Ohio Computer Repair Service.  

The Result: 
A computer that runs all the time with no errors, no surprises, 

and does it faster and better than when it was brand new. 

mailto:president@lccug.com
mailto:vp-programs@lccug.com
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mailto:treasurer@lccug.com
mailto:newsletter@lccug.com
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On Site or Walk In Services  

440-322-0259 
210 East Second St., Elyria 44035 

New Systems Upgrades 

Diagnostics Installations 

Virus Removal System Tune Ups 

Rebuilt Systems 

TUESDAY 

May 10, 2011 

TUESDAY 

May 24, 2011 

 

Smart Phones 
 

Presented by  
 

Barb Siguiron  
 

And a  

Verizon Lorain Representative 

 

Lorain Coast Guard 

Have you ever wondered what the Coat Guard actually 
does on Lake Erie? How are they connected with 
Homeland Security? 
 

The US Coast Guard Station in Lorain was established 
and built in 1904 as a US Lifesaving Service Lifeboat 
Station and formally opened at this site on the east side 
of the entrance to the Black River in 1908. 
 

Presently, Station Lorain is home to 23 Active Duty, 7 
Reservist, and 6 Auxillarist and a full Aids To Navigation 
Team. 
 

The station has 4 boats: a 41 ft Utility Boat, a 25 ft Re-
sponse Boat, a 21 ft Trailerable Aids to Navigation Boat, 
and a 16 ft Ice Skiff for Winter operations.  The Station 
is Part of the US Coast Guard's 9th District,  
Sector Buffalo. 
 

The Coast Guard is co-located with the Aids To Naviga-
tion Team (ANT) at the mouth of the Black River on 
Lake Erie's southern coast right next to downtown 
Lorain Ohio. 
 

We will set up a tour of the station later. 

So what is a Smart Phone? If you are not as phone 
savvy as you would like to be, you will be after this pro-
gram.  
 

There will be discussion on the many types of Smart 
Phones, what they do, how they are different from one 
another, how they would fit your needs and why would 
you want one? 
 

Barb will discuss the history and variety of Smart 
Phones on the market and help us understand the ins 
and outs of them with information and hand-outs. 
 

Please understand that this is NOT a sales event. NO 
PHONES WILL BE SOLD DURING OR AFTER THIS 
PROGRAM!  
 

If you are interested in what Verizon has to offer in the 
way of phones/service, please get Barb's card to meet 
with her at a later time.  
 

Thank you very much for your consideration on this 
point. 

Surf Privately 

We’re assuming as mobile travelers you’re carrying at 
most times at least one Web-connected device, if not 
more. Still, it’s possible you may find yourself in the 
situation of needing to use a public computer to connect 
to the Web in a pinch. If so, know that the Web site his-
tory and cookies you generate during your Web session 
are left behind and accessible by those using the sys-
tem after you unless you manually delete them. 
Google’s Chrome browser takes care of this for you via 
its Incognito tool, which allows for private browsing ses-
sions that keep such information from being accessible. 
Internet Explorer 8 version includes a similar feature 
called InPrivate. 

 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can  

do for you and your user group! 

http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com/
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
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http://www.smartcomputing.com/
http://www.smartcomputing.com
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Executive Board  

Meeting Minutes 
General 

Meeting Minutes 

Computer Systems Unlimited, Inc.  
 

We are a full service computer/peripheral 
sales and repair Company specializing in 
custom built Pc's, network design, software 
integration, and everything in-between. We 
are located in the small college town of 
Oberlin, Ohio, and for fourteen years have 

been providing unrivaled service to home users, small and large busi-
nesses all over Ohio as well as State and local government  agen-
cies.  All of our systems and networks are tailored to meet the individ-
ual needs of our customers. 
 

Onsite service and repair for all networks and systems, In house 
service and repair, Pick up and drop off,  Printer repair and cleaning, 
Laptop repair, Software troubleshooting, Custom designed networks 
and pc's, MAC repair, Parts replacement & Expert advice and support 
and Data Recovery. 
 

* Computer Systems Unlimited is happy to offer a 5% discount 
on all computer systems ordered by LCCUG members.  
* Computer Systems Unlimited will also offer a free computer 
diagnostics check, (a $25 value), for all LCCUG members.  
 

Visit our web site at www.csuoberlin.com for more of what we can do. 

Store Hour Monday 9-5:30 - Thursday 9-5:30 - Friday 9-5 - Saturday 9-1  

APRIL 5, 2011 
 

Attending were Sandee Ruth, Carole Doerr, Don Hall, 
Micky Knickman, Pam Rihel, Richard Barnett, Dennis 
Smith and Kaye Coller. 
 

Kaye will continue to help Pam proof read the 
INTERFACE. 
 

Carole reported there were 24 tickets left to sell for the 
laptop computer. 
 

The Q and A period for the next meeting will begin 
between 7 and 7:15. 
 

Richard will be checking with our advertisers this 
coming week. 
 

Kaye will contact Jean with regard to holding both a 
beginners and an intermediate computer class. 
 

Carole is checking the local newspapers with regard to 
publishing our upcoming meetings agendas. 
 

Dennis and Dave Strick will dispose of our computers 
presently in the Elyria Senior Center. 
 

Carole handed out information to the officers about 
grants available. 
 

Our annual picnic will be held July 31 at French Creek, 
Sheffield Village. 
 

Richard proposed the club contribute $100 for food, loan 
our projector and send volunteers to the APCUG 
Convention. 
 

Carole moved, Pam seconded the meeting be 
adjourned. 

APRIL 12, 2011 
 

President Sandee Ruth called the meeting to order. A 
motion to accept the minutes as shown in the April issue 
of the Interface was made by Carole Doerr, seconded 
by Dennis Smith. Motion Passed. 
 

Sandee then explained the importance of signing up for 
the Plumb Brook trip, Pam’s genealogy class and 
Micky’s problem solving workshop. 
 

The annual picnic has been rescheduled to July 31, 
2011 at French Creek, Sheffield Village. 
 

Sandee told the attendees of our participation for the 
upcoming APCUG  convention. 
 

The Social Networking Program started with Richard 
Barnett showing a video about Facebook and giving 
some figures as to how fast it has grown and how many 
people participate. He then presented his own Face-
book page. 
 

Sandee explained the workings of Twitter and who may 
benefit from using it. 
 

Richard then explained the security risks involved when 
giving information online. 
 

Ellen Endizal won the money raffle and Mary Butler had 
the first ticket for the software/hardware raffle. 
 

Claudia Jones name was drawn for the attendance raf-
fle, however she was not present. 
 

Ken Kohler moved, John Dunn seconded that the meet-
ing be adjourned. 

 

 

 

  

          Come see if you won  

              an HP laptop 
 

                    Laptop drawing at  

      May 10th 

                             Meeting! 

http://www.csuoberlin.com/
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 Pam Rihel  LadyGeneo@roadrunner.com 

Our Ancestors Word Meanings & How 
They Differ From Today 

 
Some of our familiar word meanings of today differ from 
what they meant to our ancestors during the colonial 
times. 
 
Here are some examples: 
 

 The terms ―niece‖ and ―nephew‖ are from the Latin 

words meaning ― granddaughter‖ and ―grandson‖, so 
you may find them used in that context. 

 Now when we use the words ―Junior‖ or Senior,‖ we 

would normally think that is the relationship between 
a father and his son.  In the past, these words were 
used much more liberally and could refer to an un-
cle and nephew, or even to two people with the 
same name who were unrelated.  How strange that 
seems to us now. 

 The words ―brother‖ and ―sister‖ also were used in 

different ways.  Members of the same church often 
referred to each other as brothers and sisters, and a 
married couple would refer to their brothers-in-law 
and sisters-in-law just as brothers and sisters. 

 The term ―in-law‖ can also cause problems.  In the 

past, ―in-law‖ relationships could be either step rela-
tionships or the regular in-law relationships that we 
think of today. 

 
Misunderstanding and misinterpreting these terms can 
really twist the branches of your family tree, so when 
you’re reading older records it is important to be cau-
tious.  When it is possible, verify information with other 
records.  This is the best way to make sure that you 
have the correct information.  In addition, look at the rest 
of the language in the document.  The more obscure the 
terms and spellings you find, the more careful you 
should be. 

Your Ancestors in the Military 
 

Here is a listing of some URL’s for Websites for our 
wars: 
  

The Revolutionary War 
www.footnote.com - pay site 
www.americanrevolution.org 
www.ancestry.com - pay site 
www.sar.org  - Son’s of the American Revolution 
www.dar.org  - Daughter’s of the American Revolu-
tion 
www.nara.gov - National Archives 
www.ogs.org - member site although some 
searches are open to the public. 
 

War of 1812 
www.societyofthewarof1812.org  - The Society of 
the War of 1812 
www.ohiohistory.org - Ohio Historical Society 
 

Civil War 
www.itd.nps.gov/civilwar - CWSS National Park 
Service 
www.ohiocicilwar.com - Ohio in the Civil War 
www.ancestry.com  pay site - Civil War Soldiers 
Database 
http://carlisle-www.army.mil/   
www.cwc.lsu.edu/  - 
Special Collections - US Civil War Center.  LSU 
www.nara.gov  - National Archives 
 

The Spanish-American War and the Philippine  
Insurrection 

www.kshs.org  - Kansas State Historical Society 
www.loc.gov/rr/hispanic/1898  - Library of Con-
gress 
www.spanamwar.com - Spanish American War 
Centennial Website 
 

World War I 
www.abmc.gov/home.php - American Battlefield 
Monuments Commission 
http://www.cwgc.org - Commonwealth Graves com-
mission 
www.ancestry.com pay site - WWI Draft Cards/
American Soldiers of WWI 
 

World War II 
www.wwiimemorial.com - World War II Memorial 
www.ibiblio.org/pha - Historical aspects.  Lots on 
Pearl Harbor 
www.nara.gov - NARA has causalities listed by 
State 

 

Korean War 
www.abmc.gov - Causalities listed by State 
www.nara.gov - NARA has info for Korea and Viet-
nam 
www.nps.gov/kwvm/ - Korean War Memorial 

(Continued on page 6) 

Surname Genealogy Search 

http://www.surnameweb.org/ 
 

Census Finder - A Directory of Free Census  

Records 

http://www.censusfinder.com/ 

mailto:LadyGeneo@roadrunner.com
http://www.footnote.com
http://www.americanrevolution.org
http://www.ancestry.com
http://www.sar.org
http://www.dar.org
http://www.nara.gov
http://www.ogs.org
http://www.societyofthewarof1812.org
http://www.ohiohistory.org
http://www.itd.nps.gov/civilwar
http://www.ohiocicilwar.com
http://www.ancestry.com
http://carlisle-www.army.mil/
http://www.cwc.lsu.edu/
http://www.nara.gov
http://www.kshs.org
http://www.loc.gov/rr/hispanic/1898
http://www.spanamwar.com
http://www.abmc.gov/home.php
http://www.cwgc.org
http://www.ancestry.com
http://www.wwiimemorial.com
http://www.nara.gov
http://www.abmc.gov
http://www.nara.gov
http://www.nps.gov/kwvm/
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 COMPUTER REPAIR 

 PRINTERS & SUPPLIES 

 UPGRADES 

* CUSTOM PC'S & LAPTOPS 

* CALL FOR BEST PRICES 

* EDUCATION DISCOUNTS 

 LCD MONITORS & TVS 

365-2288 - Elyria  1-800-238-8973 - USA  
 

591 Cleveland Street   Elyria, Ohio  44035 

Shop at    www.ROYALBUSINESS.com    and save $$$ 
 

Financing Available  -  90 days same as cash 

Vietnam War 
www.abmc.gov - Click War Dead, all Wars.  Viet-
nam 
www.no-quarter.org/ - Search by Name or city of 
residence 
http://thewall-usa.com/ - The Vietnam Memorial 
 

Desert Storm 
http://www.desert-storm.com - Desert Storm Casu-
alties  
 

War on Terrorism 
http://www.defendamerica.mil/fallen.html - Casual-
ties Lists 
 

Veteran Cemeteries 
www.cem.va.gov - National Cemetery Administra-
tion.  Gravesite locator for all categories of veter-
ans’ cemeteries. 
 

General and Miscellaneous 
US Genweb Project - Many State and County Sites 
Contain Military information. 
 
www.usmm.org - Merchant Marine, Revolutionary 
War to WWII to today. 
www.military.com - Military Unit pages.  You must 
sign up for these by Unit. 
www.newenglandancestors.org - Numerous Data-
bases, many with military information 
www.rootsweb.com - Don’t forget the mail lists.  By 
units, war, societies and much more. 
 
Compiled by Brent Morgan -  
brentster1@comcast.net 
Brent is also a member of Facebook 

(Continued from page 5) Genealogy 
 

Roundup: Search Engines  

Find What You Need 
 

When Google was launched in 1998, it indexed 26 million 

pages. The company no longer reports the size of its index, 

but according to its official blog, it indexed over a trillion 

pages as of 2008. In the face of those numbers, it’s shocking 

that Internet search works at all, let alone works so well, and 

although Google still accounts for a huge percentage of all 

search traffic, there are many more options these days for 

finding information that can help you and your business.  
 

We tested a number of general and specialty search engines to 

see which offer the best set of features and, most importantly, 

return relevant results. 
 

General Search Engines 
It’s important to note that we didn’t include Yahoo! Search 

because it’s now powered by Bing, meaning both sites return 

the same search results, and Yahoo! offers very little in the 

way of advanced search, while Bing has all sorts of options. 
 

Bing  
www.bing.com  
Bing is Microsoft’s latest entry in the search engine game and 

has quickly become a contender for the most popular general 

search engine. The site is straightforward but includes a lot of 

options, and it does a great job of returning relevant links.  
 

If you don’t mind the site maintaining a search history, it 

works really well. You can click a Search History link on the 

main search page to access a slick calendar that displays 

searches by date, along with the links you clicked after the 

search completed. Anyone who has ever had his computer 

crash while researching something with a lot of pages or tabs 

open at once knows how handy this would be for finding your 

place again.  
 

Bing’s real strengths are in the proprietary Microsoft services 

it pulls from to power many of its search results. Bing Maps 

provides clean, useful maps, and its Streetside street level 

photos are incredibly sharp and detailed (unfortunately, Street

side is only available for very limited metropolitan areas 

right now). Bing Travel search features are also fantastic 

thanks to Microsoft-specific tools such as Farecast, which 

helps you find the best day to buy airfare for the lowest price. 

Thanks to tools such as these, Bing always deserves a look 

when you’re searching. 
 

Blekko  

www.blekko.com  
Blekko (in beta at press time) is a new and interesting search 

engine that  uses what it calls slashtags to help users prune 

(Continued on page 7) 
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search results so that only relevant links appear. To use 

slashtags, you enter a search term and then a forward slash 

followed by a tag that establishes the parameters of the 

search. For example, if you want to see what bloggers are 

saying about Microsoft, type Microsoft /blogs and only re-

sults from the Web’s top relevant blogs appear. Alternatively, 

you can use a backslash before the tag to remove all results 

related to that tag, so if you type Microsoft \blogs, no blog-

related results appear. You can also combine slashtags to fur-

ther hone results.  
 

By default, results are sorted by relevance, but unlike most 

sites, you can sort them by date if you add /date in the search. 

If a slashtag that you need doesn’t exist, you can create it 

yourself, store it for future use, and even share it with col-

leagues. (You’ll need to create an account to use the slashtag 

creation feature.) Once it’s created, you associate sites with it 

that you know are relevant and other people who use the 

slashtag benefit from your knowledge. This site is already 

useful and has a ton of potential, especially for teams willing 

to create and share custom slashtags. 
 

Dogpile  
www.dogpile.com  
Searching via more than one search engine means you may 

spot great results that your first-choice search engine missed, 

but it’s a pain to repeat searches at multiple sites. Dogpile 

eliminates that pain by aggregating results from multiple 

search engines, dumping duplicate links and ranking results 

mainly based on how many other search engines also ranked 

them highly. All results are tagged with “Found On” info, 

letting you know what search engines returned it. Sponsored 

results are included but often are relevant and are clearly 

marked.  

This metasearch site aggregates results from Google, Yahoo!, 

Bing, and Ask.com. The site does a great job of sorting results 

by relevance. Dogpile may not offer much in the way of fea-

tures, but it’s definitely worthy of your attention in terms of 

convenience. 
 

DuckDuckGo  
www.duckduckgo.com  

DuckDuckGo takes the minimalist search approach to the 

logical extreme with a very clean search results page. In our 

tests, results were uniform.  
 

In a little touch that makes a huge difference, a Web site’s 

favicon appears next to search results related to that site, mak-

ing it easy to see where the link is from without having to 

read any text. (A favicon is a small icon that is associated 

with a particular site; if a site has one, it usually appears next 

to the site URL in the Address Bar.) Clicking the icon per-

forms a domain-specific search at that site. This is handy for 

quickly finding all press releases and whitepapers on a par-

ticular topic from a particular company. 

 

(Continued from page 6) 
 

DuckDuckGo also presents some  search results in interesting 

ways. For  example, when we used the search term  

“Microsoft Employees,” it returned a  virtual Rolodex of peo-

ple who work for  Microsoft (or have in the past), complete  

with a thumbnail image when  one was available. Some 

searches also  return what the company calls Zero-Click Info 

Sources. These are pulled directly from a trusted source of 

information  related to the search and appear  in a red box at 

the top of the search results  page so you don’t even need to  

click a search result to get the information  you searched for. 
 

Those are the basics, but this search engine  has plenty of 

other features going for it. It doesn’t collect or share your 

personal information; there are plenty of syntax commands 

available to refine searches; and it includes a number of cal-

culators,  converters, and fact-finding tools that make it easy 

to quickly get some basic information. This site deserves a 

spot on your search engine shortlist. 
 

Google 
www.google.com 

Now that the term “google” is used as a verb and has become 

the gold standard by which all other search sites are judged, it 

is impossible to imagine an Internet without it. It’s blazing 

fast because it maintains its vast database on its own cutting-

edge hardware. It’s up-to-date  
 

SEARCH TIPS 
Most sites have a syntax you can use to refine search results. 

Using Google, for example, you can put quotes around a 

phrase to search for that exact phrase, put a minus sign (-) 

directly in front of a term to exclude results containing it, or 

put a plus sign (+) directly in front of a term to make sure 

Google uses that precise term. 
 

DuckDuckGo is shaping up to be a useful, popular search  

(Continued on page 18) 

http://www.loraincounty.com/
http://www.dogpile.com
http://www.duckduckgo.com
http://www.google.com
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Service Packs Explained 
(and needed) 
 

By Sandy Berger, Compu-KISS 

www.compukiss.com 

sandy@compukiss.com 

 

Although most of us still think of Windows 7 as a brand new 

operating system, it is, in fact, starting to show its age. Win-

dows 7 made its debut on October 22, 2009. Is one and one-

half really old? Well, in the computer world, it is not old, but 

it is certainly full-grown. One sign of this is that Microsoft 

has just released the first Service Pack for Windows 7. 

 

A service pack is a collection of updates, bug fixes, and en-

hancements for a software program. As you know, Microsoft 

routinely offers updates for their Windows operating systems.  

These updates come out weekly and they patch or, you might 

say, repair the operating system so that they remain safe from 

hackers. They can also include improvements or enhance-

ments to the operating system. At a certain point in time, Mi-

crosoft gathers all of those updates, adds any other updates 

and enhancements they have and issues this batch of updates 

as a service pack.  It is also important to note, that when Mi-

crosoft issues a service pack, this service pack also makes 

sure that all of the updates and enhancements work well to-

gether and offer good stability for the operating system. 

 

The question that I am most often asked is this, "If I have in-

stalled every update that Microsoft has released, do I still 

need to install the service pack?" The answer is "yes." Often 

the service pack contains additional updates and/or enhance-

ments that were not included in the weekly updates. Also, a 

service pack makes sure that all of the updates are put to-

gether properly to make your system run well. 

 

In fact, Microsoft thinks that this is so important that they 

only support the operating system when it has the proper ser-

vice packs installed. Each service pack should be installed 

when it is released. If for some reason, they are installed all at 

the same time, each is installed sequentially. 

 

So, for Windows XP you should have Service Pack 3 in-

stalled. Windows Vista should have Service Pack 2, and Win-

dows 7 should have Service Pack 1. To learn what service 

pack you have installed, just click on the Start button, right-

click on Computer or My Computer, and then click Proper-

ties. You will see the service pack listed under the Windows 

edition. 

 

You can go to the Microsoft website and install a service pack 

from there, if you happen to be missing one. All service packs 

from Microsoft are free. If you are using Window 7, the new 

service pack will be offered to you through Microsoft's auto-

matic update service. This Windows 7 service pack can take 

up to 30 minutes and will re-boot your computer. I have in-

stalled Window 7, Service Pack 1 on several computers with-

out a problem, but you should be aware that installing a ser-

vice pack is a big update. Microsoft recommends that you 

back up your computer before installing a service pack. And 

to be honest, you should be backing up your computer any-

way. So if you don't have a backup strategy in place, this is a 

good time to implement one. 

 

The newest version of Internet Explorer - IE 9 is now in test-

ing and it is already available for free download in a beta ver-

sion. This is by far, the best version of Internet Explorer that 

Microsoft has ever released. IE 9 won't run on Windows XP; 

it requires Windows Vista or Windows 7. Although Microsoft 

is not requiring Windows 7 Service Release 1 to install IE 9, 

it is advisable to install this Service Release before you install 

IE 9. 

 

Service Packs are a fact of life for Windows users. Installing 

them may be a bit of a pain, but you really need them to make 

sure that your Windows system is secure and stable and that it 

performs well. 

 
There is no restriction against any non-profit group using this article as long as it 
is kept in context with proper credit given the author. The Editorial Committee of 
the Association of Personal Computer User Groups (APCUG), an international 

organization of which this group is a member, brings this article to you. 

LCCUG 

2011 Annual 

Picnic 
 

French Creek Metro Parks 

Pine Tree Picnic Area 

(off French Creek Road) 

in Sheffield, Ohio 

July 31, 2011 
12 noon to 5pm 

 

Too early for this notice? 

We think NOT! 
 

We are looking for volunteers to help with 

our annual picnic this year.  If you are in-

terested in helping out just contact either 

Carole Doerr: public_relations@lccug.com 

Or Pam Rihel: newsletter@lccug.com 
 

We will have door prizes and games. 

http://www.compukiss.com
mailto:public_relations@lccug.com
mailto:newsletter@lccug.com
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Excel allows you to easily add graphics to a worksheet. 

This can be helpful at times, but at other times you may 

want to delete all the graphics in a worksheet. The easi-

est way to delete all the graphics is to follow these steps: 

1. Press F5 to display the Go To dialog box. 

2. Click on the Special button. Excel displays the 

Go To Special dialog box. 

 

The Go To Special dialog box. 

3. Make sure the Objects radio button is selected. 

4. Click on OK. All the graphics in your work-

sheet are selected. 

5. Press the DEL key. All the graphics are de-

leted. 

This solution works only if there are no other objects 

(besides graphics) in your worksheet. If you have other 

objects that you don’t want deleted, then all you need to 

do is perform steps 1 through 4, and then hold down the 

CTRL key as you use the mouse to click on each object 

you don’t want deleted. When you are satisfied with the 

objects selected, finish up by following step 5. 

Copyright © 2011 by Sharon Parq Associates, Inc. Re-
printed by permission. Thousands of free Microsoft Ex-
cel tips can be found online at http://excel.tips.net. 

Selecting an Entire 

Paragraph 
Deleting All Graphics 

If you are using the mouse, Word provides several quick 

ways to select an entire paragraph. First, you can simply 

triple-click anywhere within the paragraph. This is per-

haps the fastest and most common method of selecting 

an entire paragraph. 

Second, you can move the mouse pointer to the left of 

the first character in any line of the paragraph you want 

to select. The mouse pointer turns into an arrow point-

ing up and right. Double-click the mouse, and the para-

graph is selected. 

Finally, if you are using the style area, you can also 

move the mouse pointer into the style area to the left of 

the paragraph you want to select. Click once on the left 

mouse button, and the entire paragraph is selected. 

If you like to use the keyboard instead of the mouse, 

you can select the current paragraph by pressing 

CTRL+UP ARROW (which moves the insertion point to 

the beginning of the paragraph) and then pressing 

CTRL+SHIFT+DOWN ARROW. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted 
by permission. Thousands of free Microsoft Word tips can be 
found online at http://word.tips.net. 

http://excel.tips.net
http://excel.tips.net/
http://word.tips.net
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LCCUG O NGOING  CLASSES  
AND  WORKSHOPS  

 ALL  ARE  FREE  AND  OPEN  TO  THE  P UBLIC  

 

  Date:  Tuesday May 17, 2011 
  Time:  5:30 - 8 pm  Instructor:  Micky Knickman, et al. 

  Place:  Amherst Church of the Nazarene 
   210 Cooper Foster Park Rd.,44001 

 

 

   Learn how to repair or update your computer by changing 
hard drives, memory, CD ROMs, etc. 
 Members are encouraged to bring their computers any-
time before 7:30 pm for assistance from Micky, Neil or other 
knowledgeable members.  

Problem Solving Workshop 

NEED HELP?— 
Here’s Who to Contact: 

 
Neil Higgins 
  

 440-967-9061 - higgins.neil@gmail.com 
 Evenings 6 p.m. -10 p.m. + Weekends 
  Hardware, Linux & Windows Operating Systems,  
 Tweaking your system 

 

Micky Knickman 
     

 440-967-3118 - micky@knickman.com 
  Evenings 5 p.m. – 8 p.m. + Weekends 
   General Software Configuration, Hardware Installation,  
 Basic to Advanced Windows 
 

Lou Koch 
    

 440-985-1585 - lkkoch@centurytel.net 
   Microsoft Office: Excel, Word, PowerPoint, Publisher, Access, & 
 Outlook, Basic to Advanced Windows 
 

Edie Lewandowski 
    

 440-282-4188 - elew@erienet.net 
   Daytime - midnight 
   Desktop Publishing, General File Management, Eudora Email, 
 MSWorks Tools,  
 

 Richard Barnett 
      

 440-365-9442 - Richard216@aol.com 
    Evenings & Weekends 
   General Software Configuration, HardwareInstallation, Basic to 
 Advanced Windows & Web Page Design 

 

Sandee Ruth  
   

 440-984-2692 - sandee29@gmail.com 
  6 p.m. - 10 p.m. except when at work 
   Basic Word Processing, Windows,  & Web Design 

   Advanced Internet  
 

Jeff Kasler 
    

 440-967-7142 - Jeffk@roadrunner.com  
   10 a.m. - 7 p.m. 

   Burning CDs using Record Now  
 

David Kennett 
    

 440-327-8624 - w8kfj@yahoo.com 
 9 a.m. - 8 p.m.   
 Video Editing & DVD Burning 
 

Cathy Ratcliff 

 

 therats1@verizon.net 
 Though she lives in Coshocton, you can call  
 740-327-1483  before 8 pm 
 Paint Shop Pro, other Photo Editing programs, 
 Microsoft Office programs  
 
Keith Kuhn 
    

 440-967-6509 - kthkuhn@yahoo.com 
 8 a.m. - 11 p.m.   
 Downloading Music & Burning CDs 

Don’t forget to check the Members’ page for up-to-date infor-

mation about programs & events: 

http://www.lccug.com/members 

Date:  Tuesday May 17, 2011 
Time: 3:00 - 5:00 pm 
Instructor:  Pam Rihel 
Place:  LCCC Learning Center. 
  St. Joe’s Com. Center,  21st & Broadway 

  

 Learn more about finding your ancestors with public re-
cords & online websites.  How to start & sources to use. 
 

You must register   -  Phone: 440-277-6076  or 
Email: LadyGeneo@roadrunner.com 

Genealogy Class 

Date:  May 10, 2011 
Time: 3:00 - 5:00 pm 
Instructor:  Jean Griffith 
Place:  LCCC Learning Center. 
  St. Joe’s Com. Center,  21st & Broadway 
 

Bring your questions if you’d like.  Jean will start with the 
basics and move on to intermediate topics if time allows. 
Learn MS Word, copying & pasting, for-matting text, saving 
files, basic file management, basic PC maintenance, etc 

 

Register by calling LCCC Learning Center:    
440-366-4507 

Beginning to Intermediate 

 Computing 

If you are a beginner or have a better understand-

ing of the computer, Jean’s class is for you. 
 
 

YOU HAVE TO REGISTER for this class, look 

at the information listed above.  Jean needs to 

know how many students she will be teaching so 

she can be better prepared.  Thank You 

mailto:higgins.neil@gmail.com
mailto:micky@knickman.com
mailto:lkkoch@centurytel.net
mailto:elew@erienet.net
mailto:Richard216@aol.com
mailto:sandee29@gmail.com
mailto:Jeffk@roadrunner.com
mailto:w8kfj@yahoo.com
mailto:therats1@verizon.net
mailto:kthkuhn@yahoo.com
http://www.lccug.com/members
mailto:LadyGeneo@roadrunner.com
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May 2011 Classes 

Class Type Location Registration May Time More Info 

Classes / Workshops 

Problem Solving 
Micky Knickman 

Amherst Church of 
the Nazarene 
210 Cooper Foster 
Park 

  
Not Required 

May 17, 2011 
5:30 to 8:00 

pm 
Page 10  

Genealogy Class 
Online & Off 
Pam Rihel 

LCCC Learning Center 
St. Joe’s Com. Center 
21st & Broadway 

 

Reg. required  
 

LadyGeneo @ 
roadrunner.com 

May 17, 2011  3:00-5:00 pm Page 10 

Beginning to Inter-
mediate Computing 
Class 

LCCC Learning Center 
St. Joe’s Com. Center 
21st & Broadway 

 

Jean Griffith 
 

Register by call-
ing:    

440-366-4507 

May 10, 2011  3:00-5:00 pm Page 10 

Is there a class you would like to teach or a class you would be interested in attending, please let one of our 
officers know. 

We want to fill this last row with something new to be taught.  

The Lorain County Chapter of OGS 
is having it’s next  meeting on : 

 
May 9, “Combing Grandpa’s Hair” presented by Lorraine 

Newsome.  Lorraine will demonstrate common techniques in 

using photo editing programs. 

 

Next  month will be “The Importance of Staying Organ-

ized” more info in June’s newsletter. 

 

Meetings are held the 2nd Monday of the month in the North 

Ridgeville Library on Bainbridge Rd., east off Rt. 83-just 

south of Rt. 20.   

 

Meetings start at: Social time 6:30; and 7:00 PM for the pro-

gram.  Meetings are free and open to the public. 
 

Come and enjoy some interesting genealogy programs. 

For direction's to North Ridgeville Library follow this link. 
 

http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-
82.014903&zoom=16&q1=35700%20Bainbridge%

20Road%20North%20Ridgeville%2C%20OH%
2044039 

Disk Cleanup 
Defragmenting your computer periodically can greatly en-

hance the computer’s performance. While helpful, all defrag-

menting does is tidy up what is on your computer; to get rid 

of unnecessary files such as temporary Internet files and 

whatever is in your Recycling Bin, run Disk Cleanup as well. 

Think of it this way: Defragmenting sweeps the floor and 

Disk Cleanup takes out the trash. Click Start, Control Panel, 

Performance And Maintenance (in Category view), and Free 

Up Space On Your Hard Disk. The Disk Cleanup will run 

automatically. Once the analysis is complete, simply follow 

the prompts.  
 

Magnify Your Screen 

If you find yourself squinting to read a Web site’s text, Win-

dows features a magnifying utility that places a window on 

the top your screen with an enlarged version of the screen 

area around your mouse. It’s a quick way to read undersized 

text and graphics, and can be found by choosing Start, Pro-

grams (All Programs in Vista), Accessories, Accessibility 

(Ease of Access in Vista), and then clicking Magnifier. Once 

you start Magnifier, a dialog box opens that allows you to set 

the magnification level and determine how the magnified 

screen will follow your actions.  
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

mailto:LadyGeneo@roadrunner.com
mailto:LadyGeneo@roadrunner.com
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://www.smartcomputing.com/
http://www.smartcomputing.com
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manufacturer like HP Advisor and Dell Support Center, 
graphics programs like Photoshop….the list is endless. 
 
So how do you determine which update requests to al-
low? One way is to open the Control Panel and choose 
―Add Remove Programs‖ in XP or ―Programs and Fea-
tures‖ in Vista and Windows 7. Become familiar with the 
list of programs installed on the computer. (If you can't 
remember all of them, at least you have a preference.) If 
one of these programs requests an update (a popup or 
notification in the lower right hand corner of the screen), 
the answer is ―Yes, thank you for keeping me current.‖ 
 
Some of the programs aren't so accommodating. Many 
can be manually updated by choosing ―Check for Up-
dates‖ under ―Help‖ on the program's menu. There may 
also be a choice under ―Options‖ (Settings, Properties, 
or some such wording) to automate the process. 
 
There is a website that can help you decide. Http://
secunia.com has an online scanner  (use ―Scan now‖ in 
the upper right corner, ―Start Scanner‖ on the next page, 
and check ―Enable thorough system inspection‖ on the 
next page before you hit ―Start‖) that will look at your 
system and list insecure programs. You can also 
download Secunia Personal Software Inspector (PSI) 
free for home users. 
 
http://filehippo.com is a source for many of the freeware 
and shareware programs we use (Adobe Reader, 
iTunes, Firefox, Open Office, AVG Antivirus, etc). You 

can download their free Update Checker which will also 
help keep you up to date with the latest versions of that 
type of software. 
 
There is no restriction against any non-profit group using this article as 
long as it is kept in context with proper credit given the author. The 
Editorial Committee of the Association of Personal Computer User 
Groups (APCUG), an international organization of which this group is 
a member, brings this article to you. 

Updates! Updates! Up-

dates! 

 

By Penny Cano,  
Member and Instructor for the Dumb & 
Dumber Workshops – Cajun Clickers Com-
puter Club, LA  March 2011 issue, Cajun 
Clickers Computer News 
www.clickers.org   ccnewsletter (at) cox.net 

 
―Something popped up on my computer saying I needed 
an update. I didn't know if it was OK, so I didn't do it.‖ 
Does this sound familiar? Updates are one of the most 
important things you can do for your computer. So what 
needs updating? The answer is almost all the software 
on your computer. Updates patch security holes that 
allow access to your computer from outside and correct 
defects in software programs. 
 
First and foremost is Windows itself. Patches fix security 
vulnerabilities and program flaws in the Operating Sys-
tem. Most people choose Automatic Updates, which 
downloads and installs these ―fixes‖ for Windows with-
out them having to worry about it. But Windows is not 
the only Microsoft program that needs updating. An op-
tion you can choose in Microsoft Update allows it to also 
take care of Microsoft Office suite, Microsoft Works, 
Windows Live, Silverlight, and a whole host of other Mi-
crosoft products installed on your computer that also 
need updating. 
 
Of equal importance are updates for your Virus/Spyware 
program or Internet Security suite.  
 
Don't know which one you're using? It's time you found 
out!! Double click on the icon in the lower right hand cor-
ner of the screen and when the program opens look for 
the date of the latest definition/update. It should be no 
later than yesterday. The virus program can only re-
move the ―bad stuff‖ if it can recognize it, and it gets 
those descriptions in the definitions downloaded from 
the Internet. 
 
Now what else needs updating? Java, Flashplayer, and 
Shockwave are three programs that deal with animation 
on websites. Adobe Reader occasionally has newer ver-
sions, but there are updates for the older versions if you 
prefer to keep them instead of upgrading. Do you have 
RealPlayer, Quick Time, or iTunes on your computer? 
Yes, they need updating too. Alternative browsers like 
Firefox, Chrome, and Safari are on the list. Add e-mail 
programs like Mozilla Thunderbird and Incredimail. 
Printer software, Support software from your computer 

Fun Photo Site 
 

http://www.hongkiat.com/blog/25-websites-to-have-fun-with

-your-photos/ 

Http://secunia.com
Http://secunia.com
http://filehippo.com
http://www.clickers.org
http://www.hongkiat.com/blog/25-websites-to-have-fun-with-your-photos/
http://www.hongkiat.com/blog/25-websites-to-have-fun-with-your-photos/
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Gmail Web Clips 
 

So, there I was, sifting through my Gmail inbox the other 
day, when I noticed a little arrow in the upper right-hand 
corner, begging to be clicked. I was pretty sure that it 
had something to do with the ads Gmail displays at the 
top of the inbox, but I let my curiosity get the better of 
me and clicked anyways.  

[1]
 

Turns out, it’s not just ads. As I clicked, I noticed  that 
the ads turned into informational snippets pulled from 
places like ESPN.com, Wired.com, Dictionary.com and 
other places. I got recipes, news, the ―Word of the Day‖ 
and sports stories as I clicked the arrow. 

[2]
 

You learn something new every day, I guess! Give it a 
try today, Gmail users! 

~Andrew 
 

Create Your Own Icon 
 

By M. Nagarajan 
 
 

Have you ever wanted to create your own icon for your 
desktop? Maybe you’re tired of all the pre-installed bor-
ing ones and you think it’s time for a change. Well, 
you’re in luck, because this article will help you create 
your very own icon. You’ll no longer have to use the 

ones that are available by default in Windows. 
 

Just follow the steps below to create your own icon. 
 
In XP, open the Paint program by going to Start, All 
Programs, Accessories, Paint. In Vista and Windows 
7, just type paint into Start search and click on the 
Paint link. 
 
In Paint, select Attributes from the Image menu. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the Attributes dialog box, change both the Width 
and the Height to 32 and select Pixels in the Units sec-
tion. 
 

You’ll notice that the height and the width of the screen 
reduced to 32 pixels will appear very tiny in the window. 
That is going to be the size of your icon. For easier 
viewing and editing, in the View menu, click on Zoom 
and Custom. Here, 800% is checked. Makes it much 
easier to see. Now, go ahead and draw whatever you’d 
like your icon to be in the Paint program. 

 
When you’re finished, save the file by going to File, and 
select Save or Save As. Go ahead and give your file a 
name, but make sure it’s formatted with the .ico exten-

(Continued on page 15) 

http://www.worldstart.com/gmail-web-clips/clark_gamil_clips_1/
http://www.worldstart.com/gmail-web-clips/clark_gamil_clips_2-2/
http://www.worldstart.com/paint-fun/
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News, Views & Tips 
 

Compiled by Joseph Moran 

 

Microsoft News 
 

Internet Explorer 6 Must Go 
 
If you’re one of the many 
people still using IE6, 
Microsoft would really, 
really like you to stop. 
The archaic, nearly dec-
ade-old browser (it de-
buted with Windows XP 
in late 2001) still repre-
sents a small but signifi-
cant portion of Web 

browser usage (around 12% worldwide as of February 
2011, according to Net Applications). As a result, many 
Web sites continue supporting IE6 despite its limited 
security features and lack of compatibility with modern 
Web standards. 
 
Microsoft’s goal is to get IE6’s worldwide share down 
below 1%, and the company has set up a Web site, 
ie6countdown.com, to spread the word among Web de-
velopers, IT admins, and users that it’s time to move 
on—preferably to a newer version of IE. 
 
Back Up Saved Windows Passwords 
In Win7, if you check the Remember My Credentials 
checkbox when entering a network username and pass-
word, the information is stored in a special location 
called the Windows Vault. In Win7, you can back up this 
vault so its stored account information will be safe and 
accessible in case you need it. 
 
To access the Windows Vault, click Start and type cred 
in the Search box. Click Credential Manager, which will 
display a list of all the credentials Windows is remem-
bering for you. This will generally include login info for 
other computers on your network (such as in a Home-
Group), as well as login info used by certain programs 
such as Microsoft Outlook or Windows Live Essentials 
applications. 
 
Click Back Up Vault and specify a location for the 
backup file—preferably a flash drive or other removable 
storage device. You’ll be prompted to press CTRL-ALT-
DELETE before assigning a password to the backup 
file, which is in Managed Information Card format (with 
a .CRD extension).  To restore from a backup, choose 
the Restore Vault option and point the wizard to the 
backup file (this will overwrite any credentials currently 

stored on the system). You can also restore the file to 
another Win7 computer.  
 

Internet Explorer 9 Launched 
 
In other Web browser news, 

Internet Explorer 9 was 

officially launched on 

March 14 and is now avail-

able through Windows Up-

date and from www.beautyoftheweb.com. 

 

IE9’s new features include a simplified UI (user interface), 

integration with Windows 7 features, improved privacy pro-

tection, hardware-accelerated graphics, and support for 

HTML5 (Hypertext Markup Language). 

 

IE9 works with Win7 and Windows Vista only (something to 

keep in mind if you’re still running WinXP). 

 

Windows Tips 
 

Readability Statistics 
 
If you want to know how easy to understand that docu-
ment or email you just wrote is, you can find out by turn-
ing on readability statistics in Word and Outlook. 
 
To enable the feature in Word 2010, click the File tab 
and select Options. Next, select Proofing, make sure 
Check Grammar With Spelling is checked, and then 
check Show Readability Statistics. Click OK. 
 
(NOTE: The readability statistics feature isn’t available 
with Word 2010 Starter, the version that comes prein-
stalled 
on many PCs.) 
 
To enable readability statistics in Outlook 2010, click the 
File tab and then click Options and Mail. Under Com-
pose Messages, click the Spelling And Autocorrect but-
ton. Finally, click Proofing. As with Word, first make sure 
Check Grammar With Spelling is enabled and then do 
the same for Show Readability Statistics. Click OK. To 
view readability stats for a document or email, run a 
spell check on it. When it’s finished, you’ll see scores for 
Flesch Reading Ease and Flesch-Kincaid Grade Level. 
The former is a 100-point scale test (generally speaking, 
higher is better) based on the number of words per sen-
tence and syllables per word, while the latter score re-
ports an approximate grade level—for example, a 9.0 
would indicate that a ninth-grader could understand the 
writing. 
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

http://www.smartcomputing.com/
http://www.beautyoftheweb.com
http://www.smartcomputing.com
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sion (.ico is for an icon file). For example, save it as 
Icon.ico. 

Now, set the Save as Type to be a 24-bit bitmap 
(*.bmp; *.dib) and then store it in any convenient folder. 
 
There you have it! You have created our own icon. Now, 
let’s see how you can replace the Windows default with 
your creation. 
 
To do this: 
Right click anywhere on your Desktop. 
Select New and then from the submenu, select Folder. 
A folder named New Folder will be created on your 
desktop. (You can change this name if you want. Just 
right click on it and choose Rename). 
 
Next, right click on the new folder and select Proper-

(Continued from page 13) Create Your Own Icon 
 

ties. 
 
Click on the Customize tab. Click the Change Icon but-
ton under the Folder icons menu. In the Change Icon 
dialog box, click on Browse and select the .ico file from 
your folder. Then click OK for the changes to take ef-
fect. 

Now you can see the icon you created. It will automati-
cally replace the default icon.  
 
 
 
 
 
 

 
 
 
 
 
 
 
It’s not only for your folders; you can also use it for any 
files, shortcuts, etc. Now, you can go and create any 
number of icons and replace all of your files and folders, 
if you choose. 
 
Go ahead and give it a try and see how it works, but 
most importantly, have fun! 
 
There is no restriction against any non-profit group using this article as long as it 
is kept in context with proper credit given the author. The Editorial Committee of 
the Association of Personal Computer User Groups (APCUG), an international 
organization of which this group is a member, brings this article to you. 

Members, if there is something you would like 
to have me put into our newsletter just let me 
know at one of our meetings or email me at: 
newsletter@lccug.com.  I would be more than 
happy to oblige you.  Pam Rihel 

mailto:newsletter@lccug.com
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Add Text on a Photo  

in Word 2007  
 

By Lynn Page, Editor, Crystal River Users Group, Florida 

December 2010 issue, CRUG newsletter 

www.crug.com         newsletter (at) crug.com 

 

When creating a document it may be useful to place text with 

or on top of a photo. You could create a new photo with the 

text in a digital photo editing application and then save it for 

use. But if you will just use that image once why go to the 

bother. Within Word 2007 you can add the text on top of your 

photo using either WordArt or a text box.   
 

Which method to use depends on the effect desired. For text 

that is short and an interesting stylized look is what you want 

WordArt is a good option. For plain and simple text a text box 

can match the text to that in the rest of the document.  
 

Text Box on Top of a Photo  
Placing a text box on a photo can be as easy as inserting the 

photo, creating a text box and dragging the text box onto the 

photo.. 

To add a photo to a document, place the insertion point in the 

document where the photo is to be located and click the Pic-

ture icon in the Illustrations group on the  Insert tab. Browse 

to the photo in the Insert Picture dialog box, select it and click 

the Insert button.  
 

To place a text box on the photo first create the text box. 

Place the insertion point on a line below the photo. Then in 

the Text group on the Insert tab, click text box and then click 

to select Simple Text Box. In the inserted Text Box type the 

text. To change the font or style of the text, highlight the text 

and then select the desired text formatting as with any other 

text. Drag the text box sizing handles to resize it as necessary. 

Finally click the outside edge of the text box and drag it to the 

proper location on top of the photo.   
 

 

The default Text Box will have white fill and a black border. 

For use over a photo you will probably want no fill color or 

border. With the Text Box still selected click Text Box Tools 

and on the Format tab, in the Text Box Styles group, click 

Shape Fill and select No Fill. Then click Shape Outline and 

select No Outline.   

 

With the Text Box you can add text on top of a photo and 

move the text to position it over the photo, but you can't rotate 

it. To be able to rotate the text or use text that is more stylized 

use WordArt.  

WordArt on Top of a Photo  
To place WordArt on the photo first create a Drawing Canvas. 

Place the insertion point in the document and then in the Illus-

trations group on the Insert tab open the Shapes drop down 

menu and click New Drawing Canvas.  

 

With the new drawing canvas still selected on the Insert tab, 

in the Illustrations  

group, click Picture. In the dialog box browse to and select 

the photo to use and click the Insert button. Again on the In-

sert tab, but in the Text group, click WordArt, select the style 

desired, and type the text. Select either piece of art and use 

the sizing handles to resize as desired. Click the outside edge 

of the WordArt to select it and drag it over the photo. Use the 

rotation handle to rotate the text to the angle that works best 

for the photo.   

 

Once the graphics are correctly formatted and positioned 

group them. That creates a single graphic that can be moved 

or resized. The text stays with the photo. To create a group 

click the outside edge of the photo, press and hold the CTRL 

key, and click the edge of the WordArt so both items are se-

lected. Under Drawing Tools, on the Format tab, in the Ar-

(Continued on page 17) 
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range group, click the arrow next to Group, and then click 

Group.  
 

There is no restriction against any non-profit group using this article as long as it 
is kept in context with proper credit given the author. The Editorial Committee of 
the Association of Personal Computer User Groups (APCUG), an international 
organization of which this group is a member, brings this article to you. 

(Continued from page 16) Add Text on a Photo in Word 2007 
 

What Is a Computer Virus? 
 

Like viruses that infect living beings, computer viruses infect 

your computer. They are software, and are often attached to 

other software or documents you might receive. When you 

run the virus's software or the file the virus has infected, the 

virus can infect your computer 's software. 

 

There are many types of viruses and terms for them, but we'll 

use the general term 'virus' to make things easy. 

 

Like the flu virus, a computer virus must spread from host to 

host to survive. When we get the flu, we cough and sneeze, 

and tiny particles carrying the virus spread the flu to other  

people. 

 

With computer viruses, the virus is designed to spread from 

your computer to other computers. Here are some of the most  

common ways they spread: 
 

1. Once the virus has infected your system, it may automati-

cally send out emails containing more copies of the virus us-

ing the address book in your email program. This type of vi-

rus is called an Internet "Worm," because it is a self-

propagating virus. For example, an Internet worm crippled 

tens of thousands of computers and slowed down parts of the 

Internet on the weekend of January 29, 2003. 
 

2. If the virus is a macro virus (attached to a Microsoft Word 

document, for example), it may attach itself to any document 

you create or modify. If you send another document to some-

one by email, the virus goes along with it. 
 

3. Sometimes viruses masquerade as a fun program (like an 

electronic greeting card) that secretly infects your system. If 

you pass the program along, not realizing that it contains a 

virus, you will be transmitting the virus manually to your  

friends, family, or colleagues. 

 

Trojan Horses are closely related to computer viruses, but 

they differ in that they do not attempt to replicate themselves. 

More specifically, a Trojan Horse performs some undesired -- 

yet intended -- action while, or in addition to, pretending to do 

something else. A common example is a fake login program, 

which collects account information and passwords by asking 

for this info just like a normal login program does. 

 

Many computer viruses are malicious -- in other words, they 

can erase your files or lock up whole computer systems. Other 

computer viruses are more benign -- they don't do any direct 

damage other than by spreading themselves locally or  

throughout the Internet. 

 

Regardless, computer viruses should always be treated. 

 
Copyright Audri and Jim Lanford.  All rights reserved. 
Reprinted with permission.  Subscribe free to Internet 

ScamBusters at http//www.scambusters.org 

 
 
 

More Than 50% Of Americans Are On  
Facebook 
 
A study from Arbitron and Edison Research found that 
morethan half of all Americans ages 12 and older have 
Facebook accounts. 
 
The research, conducted in January, indicates that 51% 
of people ages 12 and older have Facebook profiles. 
According to the report, this is up from a total of just 8% 
usage in 2008. 

L C C U G
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Say No to *72 
The scam: A terrible phone call to a Sioux Falls, SD, 
man tells him of a death in the family, asks him to call 
another number for details and to begin his cell phone 
call with the code *72. What this actually does is trans-
fer all calls sent to the cell phone to the number the 
caller has given -- the scammer's own number. 
 

The scammer then gives your number to his buddies 
anywhere in the world and they can phone him via your 
cell, with you picking up the charges -- and knowing 
nothing about it -- until you get your bill. 
 

The solution: Don't use the *72 or any other forwarding 

code to forward calls to a number you don't know or rec-

ognize. You can enter *73 to clear call forwarding. 

(We're not sure if *72 and *73 are the forwarding codes 

for all cell phones. Check your cell phone manual or talk 

to your carrier.) 

 

Cashing In On Tragedy 
The scam: A sad story and a timely warning from the 
ever-popular classified ad site CraigsList. A guy raising 
money for a terminally ill parent tries to sell furniture 
and gets a reply offering to buy. 
 
The "buyer" later says she's sent a check but it was for 
too much money -- so would the seller mind cashing it 
and sending back the difference? A wicked variation on 
the overpayment scam. 
 
Solution: Never accept a check for more than the asking 

price and then give a refund. The original check usually 

bounces and you end up holding the bag. 
 

Copyright Audri and Jim Lanford.  All rights reserved. 
Reprinted with permission.  Subscribe free to Internet 

Scambusters at http//www.scambusters.org 

 

engine. 
 

Dogpile lets you search many sites at the same time, because 

its spiders crawl the entire Internet constantly, bringing back 

fresh information.  
 

It’s also accurate because it uses a variety of algorithms to 

rank pages based mainly on what trusted sources of informa-

tion think about them. 
 

Above all, Google is powerful because so many tools lurk 

beneath its Spartan interface. On the search results page, 

clicking the magnifying glass next to an entry gives you a 

visual preview of the page so you can literally look before 

you leap. Multiple search results from a single source are of-

ten accessible by clicking a small plus sign (+) beneath the 

first result, reducing clutter. Tools on the left side of the page 

let you limit searches by how recent the links are, sort results 

by date instead of relevance, or choose a number of other op-

tions.  
 

The main downside to Google is that it is so popular. Unscru-

pulous SEO (Search Engine Optimization) tactics are often 

developed to game Google’s ranking system, floating irrele-

vant links to the top of the search results at the expense of 

relevant links. In early 2011, the effects of this became obvi-

ous as we noticed a lot of what Google calls “low-quality” 

sites turning up in the first few pages of search results. 

Google fought back by releasing some updates to its ranking 

algorithm that have once again turned it into arguably the 

most accurate search engine on the Web. 
 

Specialty Search Engines 
Often, the search results from a general search engine require 

digging through a lot of secondary sources to get to primary 

sources, or they just get so cluttered up with results that a 

critical piece of information you’re looking for remains bur-

ied.  Try some of these specialty search engines when the 

general ones fail you. 

 

DeepDyve 

www.deepdyve.com 

Sometimes the information you need is hidden away in aca-

demic or trade journals that are shielded from traditional 

search engines. DeepDyve provides a convenient way to 

search these types of publications, read brief previews of each 

returned article, and then rent articles for reading in the site’s 

proprietary reader for as little as 99 cents. Once rented, the 

articles can be viewed from between 24 hours to an unlimited 

period of time, depending on what type of account you set up 

and publisher restrictions. This is often much less than it 

would cost to purchase the article as a PDF (Portable Docu-

ment Format) from the journal’s Web site. It’s a terrific and 

inexpensive compromise relative to purchasing a complete 

article that you’ll potentially only read once and never refer-

ence again. 

 

(Continued from page 7) The Internet Archive  
www.archive.org 

As the Internet grows, old and abandoned sites are shed like 

snakeskin.  
 

Why buy articles when you can rent them inexpensively via 

DeepDyve? 
 

Google constantly improves its search tools so it can deliver 

relevant search results. 
 

With the help of The Internet Archive, you can find old ver-

sions of many Web sites.  
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

http://www.scambusters.org/scamlines.html##
http/www.scambusters.org
http://www.scambusters.org/
http://www.deepdyve.com
http://www.archive.org
http://www.smartcomputing.com


May 2011|  Interface Volume 23 Issue 5| Page  19 

Newsletter Editor:  Pam Rihel using Microsoft Publisher, Corel 
Paint Shop Pro X3, CreataCard 8.  

 

This Month’s contributors: Micky Knickman, Sandra Ruth, Kaye 
Coller, Pam Rihel, Carole Doerr, Don Hall, Brent Morgan, Sandy 
Berger, Penny Cano, Joseph Moran, Lynn Page, APCUG, 
Wordtips.net, Exceltips.net, Smart Computing Magazine, Microsoft 
Office art online, PC Computer Magazine, CPU, 
 

Newsletter is now 
Online 

at 
lccug.com/newsletters or lccug.com 

The Butterfly Site  
 
By Amanda 
 

 
 
 
 
 
 

Welcome to the Butterfly Site, where you'll learn every-
thing you can imagine about butterflies, from gardening 
to biology, it's all here.  
 
Gardening - This sec-
tion will tell you exactly 
how to make a butter-
fly garden. From plant-
ing the right plants for 
both the caterpillar and 
the adult butterfly to up
-keeping a butterfly 
garden. Did you know 
that those dreaded 
dandelions and clover, 
actually help attract 
butterflies? Who knew 
that weeds would be 
butterfly food?  
 
 

 

Fun Facts - I love sites that have fun fact sections 
about whatever the site topic is. Did you know: Butter-
flies range in size from a tiny 1/8 inch to a huge almost 
12 inches; Butterflies can see red, green, and yellow; 
Some people say that when the black bands on the 
Woolybear caterpillar are wide, a cold winter is coming.  
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pictures - This section has a lot of pictures, obviously, 
but it also has great links to other sites with pictures. 
Like I found terrific wallpapers on the link called Best 
Free Butterfly Wallpapers and Free Butterfly Screen-
savers. 

The rest I leave for you to discover on your own. Check  
out these butterflies! 
http://www.thebutterflysite.com/  
 
Do you have a cool, non-commercial site that you want  

to share? 
 

Send it to Amanda at amanda@worldstart.com  

http://www.wordtips.net
http://www.exceltips.net
http://www.lccug.com/newsletters
http://www.lccug.com
http://www.thebutterflysite.com/
http://www.thebutterflysite.com/
mailto:amanda@worldstart.com


ways to keep track of where you have been and the in-
formation that you do not want to lose. Often people will 
get distracted by a rabbit trail when researching a cer-
tain topic. Instead of clicking an interesting link and 
thereby navigating away from the page you were read-
ing, right-click the link and select Open in New Tab. The 
new page will open but the old page will stay up as well 
so you can go back to it without having to hit the Back 
button on your Web browser.  
 

Save The Page  
If you're using Internet Explorer and you come across a 
Web page with information you want to preserve, there 
are two good ways to keep the information without hav-
ing to use a Web browser to bring it back up. The first 
and simplest way is to print it; it never hurts to have a 
hard copy of information you need. Another method is to 
save the Web page as an .MHT (Multipurpose Internet 
Mail Extension) file, which is essentially just a snapshot 
of the page. In this format you can send the page to oth-
ers or double-click on it to open it directly. To make 
a .MHT file from a Web page, click File, Save As, and in 
the dialog box be sure to select the .MHT file type. Tell 
the computer where to put the file and click Save.  
 

Flash With Care  
You may know that a firmware update may sometimes 
solve problems with your DVD burner and/or expand the 
list of blank media brands and speeds the drive sup-
ports. Just pay attention to the update instructions in the 
Readme file or on the download page. For instance, 
some LG drives require you to place them as the Mas-
ter, and only, device on the IDE data cable during a 
flash update. Also, many firmware update utilities re-
quire you to turn off your antivirus, antispyware, and 
other security applications during the update process. 
Remember that if the flashing session fails or is inter-
rupted, your DVD drive might be useless afterward, so 
follow the directions.  
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

Quick Auto Correct Tricks 

AutoCorrect usually provides a helping hand by fixing 
common spelling errors automatically, but you can also 
use it to create symbols that spice up your document 
and can make it more accurate. For example, typing (c), 
(r), and (tm) create ©, ®, and ™ symbols, respectively. 
Typing --> or <-- creates à or ß symbols, respectively. 
 

Skip A Bullet Or Number  
There can be times when you're working with a bulleted 
or numbered list when you want to add a new line with-
out tacking on a number or bullet. Perhaps you want to 
add a parenthetical note below an entry without making 
it part of your list. If you hold SHIFT and press ENTER, 
Word will add a new line to your list without a bullet a 
number. When you want to resume numbering or bullet-
ing, don't hold the SHIFT key any longer.  
 

Rapid Fire Zooming  
You can save a lot of time zooming in and out of Micro-
soft Office documents if you have a mouse with a scroll 
wheel. When you have an Office file such as Word, Ex-
cel, or Publisher open, hold the CTRL key down. To 
zoom in, roll the scroll wheel forward and vice versa to 
zoom out. 
 

Save Time By Saving All  
The very nature of multitasking means having many 
documents and applications open at once. If you are 
working on more than one Word document, you can 
save them all at the same time using a keyboard short-
cut. Hold the shift key and click the File pull-down menu. 
A new Save All command should appear; click this to 
save all the Word documents simultaneously.  
 

Open In A New Tab  
When researching on the internet for a project, it can be 
easy to just plow through Web page after Web page 
while you search. If you're using the latest version of a 
tabbed browser, such as Microsoft's Internet Explorer or 
Mozilla's Firefox, there are a few excellent and simple 
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MEMBERSHIP WITH LCCUG:  
 Yearly dues are $25 .  For more information, contact: 

 

Director of Membership, 

membership@lccug.com. 

 

Directions to Meetings: 
A map and directions to our meetings can be found on our 

Members’ web page www.lccug.com/members.  Just click 

on the link “Meeting Locations & Directions” 
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